
www.SlimAcademy.nl

Voorbeeldsamenvatting | Inleiding in de Methodologie en
Statistiek | Bachelor 1

Psychologie | Universiteit Leiden

2022 - 2023

ULPS-572-270 | €0,00

Tentamengericht | Overzichtelijke structuur
Sinds 1994 | Beoordeeld met een 8,2



Kan iemand uitleggen waarom het
antwoord van vraag 4 B is? 

Weet iemand waar ik de
antwoorden kan vinden van het
oefententamen? 10:10

10:10

Join onze
community

Scan de QR code of ga naar
SlimAcademy.nl/join

WhatsApp met jouw mede-studenten
Stel al jouw vragen aan onze studie-experts
Krijg gratis voorbeeldsamenvattingen
Krijg gratis extra oefenopgaven en
supplementen 

Is het college morgen
eigenlijk fysiek of online? 10:10



Samenvatting Inleiding in de Methodologie en Statistiek 2022/2023

Voorwoord

Beste student,

Leuk dat je dit jaar Psychologie gaat studeren! Voor je ligt de samenvatting van het vak Inleiding
in de Methodologie en Statistiek. Slim Academy heeft de belangrijkste studiestof voor je
samengevat. Zo kun jij zo prettig mogelijk studeren. We wensen je alvast succes met studeren en
natuurlijk met het behalen van jouw eerste studiepunten!

Nu 1 MAAND GRATIS bij een abonnement!
Wil jij de Slim Academy samenvattingen van jouw vakken altijd als eerste  in huis hebben zodat jij
op tijd kan beginnen met studeren? Gebruik dan de kortingscode STARTSLIM bij het afsluiten van
een abonnement en krijg de eerste maand van jouw abonnement helemaal gratis!
Ga hiervoor naar www.slimacademy.nl en kies je jaar. Deze code is geldig t/m 30 september
2022.

Werken bij
Slim Academy is altijd op zoek naar gemotiveerde studenten! Lijkt het je leuk om bij ons aan de
slag te gaan met het samenvatten en nakijken van samenvattingen? Dan is de rol van Studieheld
zeker iets voor jou. Je kunt werken vanuit huis, krijgt een riante vergoeding en je hebt een
studiegerelateerde bijbaan die goed op je cv staat. Heb je interesse? Stuur dan jouw motivatie en
cv naar klantenservice@slimacademy.nl.

Auteursrechten voorbehouden
Houd er rekening mee dat onze samenvattingen beschermd zijn door de auteurswet. Dat
betekent dat het doorverkopen of delen van onze fysieke en/of digitale samenvattingen illegaal
is. Als je wilt dat wij samenvattingen kunnen blijven aanbieden, verzoeken wij je jouw eigen
exemplaar te kopen. Als je vragen hebt of schendingen van het auteursrecht wilt melden, kun je
contact met ons opnemen via klantenservice@slimacademy.nl.

Stay in touch
Wil je verder op de hoogte blijven van de ontwikkelingen bij Slim Academy? Kom in contact via:
www.slimacademy.nl
@SlimAcademy.nl
klantenservice@slimacademy.nl
010 214 32 45

We wensen je veel succes met studeren en bij het halen van jouw tentamens!

Te�m ���� Aca���y
P.S. De samenvatting is geschreven naar eigen inzicht van de auteur. Het is en blijft een samenvatting, die als
aanvulling op de verplichte lesstof gezien moet worden en geen vervanging is van de verplichte lesstof.
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Informatie over het vak

Je staat op het punt de voorbeeldsamenvatting van je eerste vak van de studie Geneeskunde te
lezen. Hierin hebben we de eerste drie casussen opgenomen. De overige casussen vind je in de
volledige samenvatting.

Studenten die starten met de studie Psychologie in Leiden vinden het vaak uitdagend om de
diepgang te bepalen van de stof die je zult moeten leren voor het tentamen. Maar maak je geen
zorgen, we hebben deze samenvatting geschreven met als doel je door dit vak heen te helpen.
Meerdere topstudenten, die recentelijk dit vak hebben gevolgd, hebben hun expertise gedeeld
en aan deze samenvatting gewerkt, om je te helpen met de dingen waar de meeste studenten
mee worstelen bij het studeren van Psychologie.

We hebben gewerkt aan de volgende punten om je de beste hulp te bieden:
● Analyseren van oude examens om inzicht te geven in wat er wordt gevraagd;
● Eerstejaars studenten betrokken bij het maken van deze samenvatting, om ervoor te

zorgen dat het is geschreven op een manier die het beste is voor jou om mee te
studeren;

● Gebruiken van oefen- en voorbeeldoefeningen op examenniveau, zodat je de beste
werkwijze krijgt.

Hoe kan je het beste studeren?
Tijdens het studeren voor dit vak, is het aanbevolen dat je ook delen uit het boek bestudeert voor
een beter begrip, omdat het extra informatie biedt. Oefenen is ook de sleutel tot een goed cijfer
voor dit examen. Om je goed voor te bereiden op het tentamen zou je veel oefenvragen kunnen
maken. Zo kun je jezelf testen op je verworven kennis van de afgelopen periode. Op deze manier
kun je beter de vragen van het examen beantwoorden. Je vindt een paar van zulke oefeningen in
dit boekje.

Wat voor samenvattingen bieden we aan en wanneer kun je ze verwachten?
Voor Psychologie maken wij verschillende typen samenvattingen. Hieronder vind je een overzicht
van deze samenvattingen en wanneer je deze kan verwachten deze periode.

Studiehulp Wat houd het in? Wanneer?

Literatuur Deze samenvatting behandelt alle relevante
literatuur voor het tentamen.

3 weken na de start
van het blok

Hoorcolleges Deze samenvatting behandelt alle hoorcolleges
en bevat ook oefenopgaven.

2 weken voor het
tentamen

Succes met studeren!
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Hoofdstuk 1: Onderzoek in de gedragswetenschappen

Introductie
Dit hoofdstuk komt overeen met de studiestof zoals deze is behandeld in paragrafen 3.1.1 t/m
3.6.2 van de verplichte literatuur. Verplichte literatuur: Leary (2014), hoofdstuk 1.

Het  begin van gedragsonderzoek
Wanneer men denkt aan een wetenschapper denkt men vaak aan een ‘crazy scientist’ in een
labjas en wanneer men denkt aan een psycholoog denkt men vaak alleen aan iemand die zich
bezighoudt met het behandelen van mentale stoornissen. Psychologie is echter ook een
wetenschappelijke discipline die gedrag en mentale processen bestudeert. Al eeuwen lang zoekt
men verklaringen voor gedrag. Aristoteles en Boeddha waren één van de eerste die
systematische vragen stelden over waarom mensen zich op bepaalde manieren gedragen. Deze
benaderingen waren een hele lange tijd echter compleet speculatief, mensen zochten
antwoorden in alledaagse observatie en religieuze doctrine. Ze hadden geen manier om de
validiteit van hun verklaringen te toetsen en konden dus niet weten of deze verklaringen accuraat
waren. In de laatste 25 jaar van de 19e eeuw is, door de invloed van wetenschappers als Wundt,
James en Watson, de wetenschappelijke psychologie geboren. Zij lieten zien dat vragen over
gedrag ook getest konden worden zoals vragen in gevestigde wetenschappen als scheikunde en
biologie.

Doel van gedragsonderzoek
Onderzoekers maken onderscheid tussen twee primaire types van onderzoek die verschillen in
het doel van de wetenschapper:

● Basic research: Wordt uitgevoerd om de psychologische processen die de basis vormen
van gedrag te begrijpen zonder dat ze direct toegepast kunnen worden, het primaire doel
is kennis vergroten;

● Applied research: Hier is het doel om oplossingen voor bepaalde problemen te vinden in
plaats van algemene kennisvergroting over psychologische processen. Psychologen
worden wel eens ingehuurd om problemen in bedrijven op te lossen vanuit hun kennis.

● Sommige wetenschappers spreken ook van evaluation research (program evaluation), zij
gebruiken gedragsonderzoek methoden om de effecten van een sociaal of institutioneel
programma op gedrag te meten, bijv. effectiviteit meten van nieuw schoolprogramma.

De bovenstaande onderscheiding is soms handig, maar het is vaak ook moeilijk om onderscheid
te maken. Ondanks dat de wetenschapper een bepaald doel heeft kan zijn onderzoek ook
componenten van beide soorten hebben. Veel basic onderzoek is meteen toepasbaar en veel
toegepast onderzoek levert ook belangrijke inzichten over psychologische processen. Het verschil
ligt alleen in het doel van de onderzoeker. Bovendien vullen beide vormen van onderzoek elkaar
ook aan en zijn ze deels afhankelijk van elkaar. Onderzoek heeft altijd één van de drie volgende
doelen:

● Gedrag beschrijven (‘description’): Sommig onderzoek focust zich vooral op het beschrijven
van patronen in gedrag, gedachten en emoties. Bijvoorbeeld het beschrijven van
leeftijdsgerelateerde veranderingen in gedrag;

● Gedrag voorspellen (‘prediction’): Veel onderzoekers zijn geïnteresseerd in het voorspellen
van gedrag. Bijvoorbeeld het voorspellen van werk- of schoolprestatie aan de hand van
een gestandaardiseerde test. Deze testen moeten aan een aantal belangrijke statistische
criteria voldoen en kritisch geanalyseerd worden;

● Gedrag verklaren (‘explanation’): Veel onderzoekers vinden dit het belangrijkst doel van
onderzoek. We begrijpen iets niet echt tot we het kunnen verklaren.
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Volkspsychologie
In tegenstelling tot natuurwetenschappen zijn gedragswetenschappers bezig met onderwerpen
waar iedereen bekend mee is. Weinig mensen claimen veel af te weten van atomische deeltjes,
maar iedereen weet wel, uit persoonlijke ervaring, iets over gedachten, gedrag en emoties.
Ondanks dat psychologie vaak resultaten vindt die overeenkomen met gezond verstand (waarvan
mensen menen dat ze daar zelf ook wel mee zouden kunnen komen) gaat het ook wel eens tegen
algemene overtuigingen in. Een voorbeeld is de ‘volksovertuiging’ dat je als ouders niet direct
naar je huilende baby moet gaan omdat ze dan verwend worden. In realiteit zorgt een hogere
parental responsiveness juist voor minder veeleisende baby’s. Deze algemene overtuigingen
kunnen ook wetenschappers beïnvloeden en verblinden voor alternatieve verklaringen voor hun
resultaten. Meestal leiden deze common sense ideeën ons in de goede directie, maar soms
kunnen ze dus ook verblinden voor de daadwerkelijke werking van psychologische processen.

Het nut van leren over onderzoek
Het bestuderen van de methodologie van onderzoek heeft vier belangrijke voordelen voor jou als
student:

● Kennis over onderzoeksmethoden helpt mensen om studies die relevant zijn voor hun
professie te begrijpen. Dit is van belang om up-to-date te blijven met nieuwe bevindingen.

● Kennis over methodologie zorgt ervoor dat we wetenschappelijke bevindingen in ons
alledaagse leven beter kunnen analyseren. Het is van belang bevindingen kritisch te
kunnen analyseren voor belangrijke persoonlijke en maatschappelijke keuzes.

● Bovendien ontwikkel je het vermogen om kritisch te denken. Wetenschappers stellen
kritische vragen, proberen alternatieve verklaringen te bedenken, bekritiseren hun eigen
conclusies en willen hard bewijs vinden. Veel mensen vinden deze vaardigheden handig
om problemen op te lossen in hun dagelijkse leven.

● Kennis over onderzoeksmethodologie helpt iemand om een expert te worden in niet
alleen deze methodologie, maar ook in specifieke onderwerpen. Zo kunnen eerdere
onderzoeken in het onderzoeksveld gelezen en begrepen worden en weet iemand hoe ze
data moeten verzamelen en hoe ze resultaten op een correcte manier moeten
interpreteren.
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De wetenschappelijke benadering
Of iets wetenschappelijk is heeft, in tegenstelling tot wat mensen vaak denken, vrij weinig te
maken met het onderwerp wat onderzocht wordt. Hoe het onderwerp onderzocht wordt bepaald
of het wetenschappelijk is. Onderzoek naar emoties kan dus even wetenschappelijk zijn als
onderzoek naar quantumfysica, als het maar op goede systematische wijze gebeurt. Er zijn drie
criteria waaraan voldaan moet worden wil een onderzoek zich wetenschappelijk mogen noemen.

● Systematisch empirisme: Empirisme verwijst naar het vertrouwen in observaties om
conclusies te trekken over de wereld. Wetenschappers stellen dat conclusies puur op
observatie gebaseerd moeten worden zonder achterliggende assumpties of
overtuigingen. Observatie alleen is echter niet genoeg, dit moet systematisch gebeuren.
Wetenschappers structuren hun observaties op een systematische wijze zodat ze hier
valide conclusies over de wereld uit kunnen trekken;

● Publieke verificatie: De methoden en resultaten van het onderzoek moeten openbaar
zijn zodat de bevindingen van de ene onderzoeker geobserveerd, gerepliceerd en
geverifieerd kan worden door anderen. Dit zorgt ervoor dat anderen kunnen zien dat wat
bestudeert wordt ook echt en observeerbaar is en niet is verzonnen. Daarnaast zorgt het
ervoor dat onderzoek verbeterd kan worden. Andere onderzoekers kunnen dan nog
fouten in methodologie of interpretatie vinden die dan verbeterd kunnen worden.
Bovendien kunnen onderzoekers zo ook verder bouwen op het werk van anderen.

● Het laatste criterium is dat wetenschap zich alleen bezighoudt met oplosbare problemen.
De vraag of engelen bestaan is niet wetenschappelijk omdat er geen enkele manier is om
dit op een empirische en systematische manier te bestuderen.

Twee taken van een wetenschapper: Fenomenen detecteren en verklaren
Wetenschappers zijn gericht op twee verschillende taken:

● Ten eerste zijn ze bezig met het ontdekken en documenteren van nieuwe fenomenen,
patronen en relaties. Oude beelden over wetenschappers veronderstellen dat ze alleen
maar bezig zijn met het toetsen van hypotheses. Soms is het niet mogelijk om op basis
van een hypothese een onderzoek te verrichten omdat er nog geen theorie bestaat over
het verschijnsel dat bestudeerd wordt. In dat geval is het beter om een onderwerp te
ontwerpen om een verschijnsel te beschrijven in plaats van om een hypothese te toetsen.

● De tweede taak is om verklaringen voor fenomenen te ontwikkelen en te evalueren.
Wanneer een fenomeen ontdekt is en er genoeg informatie verzameld is, is het belangrijk
om een theorie te ontwikkelen die de geobserveerde patronen kan verklaren en om deze
te toetsen.

Een theorie is een set proposities die proberen om de relatie tussen concepten te verklaren.
Theorieën zijn alleen valide wanneer ze gesteund worden door empirische observaties, een
theorie moet dus consistent zijn met de feiten zoals ze momenteel bekend zijn. Een goede
theorie moet aan de volgende eisen voldoen:

● Een causale relatie voorstellen: Uitleggen hoe een (aantal) variable(n) leiden tot een
cognitief, emotioneel, gedragsmatige of fysiologische reactie;

● Coherent zijn: duidelijk, eenvoudig, logisch en consistent;
● Zuinig zijn: Zo min mogelijk concepten en processen gebruiken om het fenomeen uit te

leggen;
● Toetsbare hypotheses genereren: Moet ontkrachtbaar zijn door verder onderzoek;
● Stimulerend: Andere onderzoekers aanzetten om onderzoek te verrichten om de theorie

te testen;
● Een bestaande theoretische vraag oplossen.

Modellen zijn sterk verwant aan theorieën, onderzoekers gebruiken de termen zelfs door elkaar
heen, maar toch is er een verschil. Terwijl een theorie uitlegt waarom en hoe concepten
gerelateerd zijn, specificeert een model alleen hoe ze gerelateerd zijn. Modellen zijn dus
beschrijvend en theorieën zijn verklarend.
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Onderzoekshypotheses
Wetenschappers zijn veel bezig met het testen van theorieën en modellen om hun bruikbaar
voor het verklaren en voorspellen van gedrag te bepalen. Mensen kunnen gewoonweg
verklaringen vinden voor bijna alles nadat het heeft plaatsgevonden, dit soort retrospectieve
verklaringen worden post hoc explanations genoemd. Wetenschappers zijn sceptisch over dit
soort verklaringen door het gemak waarmee we ze verzinnen.

De mate waarin een theorie kan voorspellen wat er gaat gebeuren is veel interessanter. Om hun
theorie overtuigend te testen omen wetenschappers hierom met hypothese a priori - voor het
verzamelen van de data. Theorieën zijn in hun geheel vaak te breed om direct te testen. Daarom
toetsen wetenschappers dit indirect met behulp van hypotheses dit zijn specifieke verwachtingen
die zijn afgeleid uit de theorie.

De afleiding van hypotheses uit een theorie gaat via deductie. Dit is een vorm van redeneren die
van een algemene propositie (de theorie), specifieke implicaties (de hypotheses) afleid. Het is een
als-dan statement: als A, dan B.

Niet alle hypotheses zijn deductief afgeleid uit een theorie. Vaak komen wetenschappers op
hypotheses door inductie, een hypothese extraheren uit een aantal feiten. Deze hypotheses die
gebaseerd zijn op patronen in resultaten noem je empirical generalizations.
Een hypothese moet altijd zo zijn opgesteld dat hij ontkracht kan worden (falsifieerbaar) door de
data die is verzameld. Dit is een punt van kritiek op de psychoanalyse van Freud, deze is zo
opgesteld dat hij nooit te falsifiëren is. Het is namelijk niet mogelijk het onderbewuste
wetenschappelijk te toetsen. Sommige studies zijn beter ontworpen en geconceptualiseerd
waardoor ze sterker bewijs leveren dan andere studies. Daarnaast vinden we bevindingen
overtuigender des te meer methoden en technieken er gebruikt zijn om een theorie te testen in
verschillende experimenten, hiernaar wordt gerefereerd als methodological pluralism. Als er
meer tegengestelde theorieën over een verschijnsel zijn dan is het mogelijk om een studie te
ontwerpen die de tegenstelling hypotheses tegelijkertijd test, strategy of strong interference. Als
de ene theorie juist is dan is de andere theorie gelijk onjuist. Dit soort studies leveren sterker
bewijs dan studies die een enkele theorie toetsen.

Conceptuele en operationele definities
Er zijn twee manieren om een concept te definiëren:

● Conceptuele definities: Dit is min of meer de definitie zoals in een woordenboek;
● Operationele definities: Het definiëren van een concept door precies te specificeren

hoe het concept gemeten en opgewekt gaat worden in jouw onderzoek.

Bewijs, weerlegging en het wetenschappelijk proces
Een theorie kan dus alleen indirect getest worden door hypotheses, hierdoor kan een theorie ook
niet bewezen worden uit data van een onderzoek. Ze kunnen alleen ondersteund worden door
de bevindingen. Als de hypothese van een onderzoek waar is, betekent dit nog niet dat de theorie
waar is. De hypothese kan ook waar zijn terwijl de theorie compleet fout is. In de taal van logica is
het invalide om het antecedent van een argument (de theorie) te bewijzen vanuit the consequent
(de hypothese), een theorie bewijzen is dus logisch onmogelijk.
Het is logisch gezien wel mogelijk dat een theorie niet waar is. Als ik hypothese X afleid uit theorie
Y, en dan vind dat hypothese X niet bevestigt wordt door de data, dan moet theorie X dus onwaar
zijn. Bij het toetsen van hypothesen van onderzoek in de echte wereld komen echter een aantal
praktische problemen kijken die ertoe kunnen leiden dat de hypothese ontkend wordt door de
data terwijl de theorie waar is. Voorbeelden van zulke problemen zijn het gebruik van slechte
meetinstrumenten, een biases sample hebben, het falen van de instandhouding van externe
variabele onjuiste designs of statistische analyses.
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Als bewijs logisch onmogelijk is en tegenbewijs praktisch onmogelijk is, hoe gaat de wetenschap
dan vooruit? Theorieën worden beoordeeld op basis van het verzamelde bewijs van een groot
aantal studies. Als veel verschillende studies resultaten vinden die overeenkomen met de theorie,
is er bewijs dat deze theorie zo maar waar kan zijn en als veel studies juist geen overeenkomende
resultaten vinden dan is er waarschijnlijk iets mis met de theorie. Je kan de wetenschap ook zien
in termen van filters. Eerst bedenkt men een heleboel mogelijke verklaringen voor een
fenomeen, vervolgens worden door wetenschappers plausibele verklaringen behouden en
verder getest terwijl de niet plausibele verklaringen wordt afgewezen. Hoe meer er gefilterd
wordt, hoe minder potentiële verklaringen overblijven. Dit wordt nog wat verder uitgelegd.

Het wetenschappelijke filter
Stel je een tunnel voor die vier filters bezit waar ideeën doorheen kunnen stromen, elk
opeenvolgend filter met een kleiner gat dan de vorige. De bovenste laag bestaat uit alle ideeën,
overtuigingen et cetera die in de onderzoeker opkomen, daarna volgen vier filters:

● Een groot deel van de ideeën van de bovenste laag zijn heel onwaarschijnlijk. Met behulp
van hun opleiding en training filteren wetenschappers onmiddellijk een groot aantal
ideeën eruit aangezien deze duidelijk belachelijk of consistent met eerdere kennis zijn. De
ideeën die filter 1 passeren zijn niet noodzakelijk valide, maar ook niet complete
flauwekul;

● De tweede filter bestaat uit de onderzoeker zelf, hij of zij bepaalt welke ideeën het waard
zijn om te onderzoeken. Als de kans op interessante bevindingen en een
wetenschappelijke publicatie groot is zal de onderzoeker waarschijnlijk doorzetten. Als de
kans groot is dat het nergens toe zal leiden wordt het idee verworpen;

● Filter drie is de peer-review. Het werk van de onderzoeker moet namelijk wel nog voldoen
aan de methodologische standaarden van hun peers (mede wetenschappers). Als dit het
geval is, en het draagt bij aan extra kennis dan besluiten de reviewers dat het
gepubliceerd kan worden. Het is niet zo dat filter drie al onderzoek wegfiltert wat niet
noodzakelijk is, maar het filtert wel veel error en bias;

● De laatste filter omvat het gebruik, replicatie en toevoeging van anderen. Alleen
onderzoek dat veel geciteerd en gebruikt wordt door andere onderzoekers wordt
onderdeel van de gevestigde wetenschappelijke literatuur.

Als een theorie alle vier de filters heeft doorstaan betekent dit niet dat de ultieme waarheid is
gevonden. Door het wetenschappelijk filter en steeds nieuwe hypothesen te testen komen we
steeds dichter bij de waarheid, het blijft echter altijd onzeker of dit de ultieme waarheid is.

Onderzoekstechnieken van gedragsonderzoek
Al het gedragsonderzoek kan worden onderverdeeld in vier brede methodologische categorieën:

● Beschrijvend onderzoek: Beschrijft het gedrag, gedachten en/of emoties van een
bepaalde groep. Bijvoorbeeld het beschrijven van typisch gedrag voor kinderen van een
bepaalde leeftijd. Beschrijvend onderzoek vormt de basis voor al het ander onderzoek;

● Correlationeel onderzoek: Onderzoekt de relatie tussen verschillende psychologische
variabelen. Is het vermogen om te dealen met stress gerelateerd aan fysieke gezondheid?
De correlatie wordt berekend, we kunnen hieruit echter niks zeggen over oorzaak-gevolg;

● Experimenteel onderzoek: Onderzoekt of bepaalde variabele verandering in gedrag,
gedachten en emoties veroorzaakt. De onderzoeker manipuleert de onafhankelijke
variabele om dit te zien of dit veranderingen in gedrag (dependent variable) veroorzaakt.
Als dit zo is kunnen we concluderen dat de onafhankelijke variabele de oorzaak is;

● Quasi-experimenteel onderzoek: Van deze techniek wordt gebruik gemaakt als er geen
onafhankelijke variabele gemanipuleerd kan worden (bv. geslacht of leeftijd) of de
externe factoren niet constant kunnen worden gehouden. De wetenschapper onderzoekt
de effecten van een variabele of gebeurtenis die op natuurlijke wijze voorkomt, dit geeft
niet zoveel zekerheid als een experimenteel onderzoek.
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Dieronderzoek
Soms worden dieren gebruikt in psychologisch onderzoek, vooral ratten, muizen en duiven zijn
populair. Het voordeel aan dieren is dat de omgevingsfactoren veel makkelijker constant kunnen
worden gehouden, bijvoorbeeld door in het laboratorium gecontroleerd opgevoed te worden. De
invloed van externe factoren wordt zo geminimaliseerd. Ook kunnen ze voor een heel lang
onderzocht worden. Daarnaast kan er met bepaalde medicaties of chirurgische ingrepen
geëxperimenteerd worden voor dit op mensen gebeurt. Door dieronderzoek weten we nu veel
meer over basic drives als honger en seksueel gedrag. Ook over processen in zintuigen als reuk,
visie en vooral pijn hebben we veel geleerd van dieren. Tot slot hebben ze ons veel geleerd over
klassieke- en operante conditionering en de werking van de hersenen (aangezien we de hersenen
van dieren veel makkelijker kunnen manipuleren).
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Hoofdstuk 2:  Gedrags Variabiliteit en onderzoek

Introductie
Dit hoofdstuk komt overeen met de studiestof zoals deze is behandeld in paragrafen 3.1.1 t/m
3.6.2 van de verplichte literatuur. Verplichte literatuur: Leary (2014), hoofdstuk 2.

Een schema verwijst naar een cognitief referentiekader die inkomende informatie organiseert en
stuurt. De reactie van mensen op stimuli of gebeurtenissen kan sterk worden beïnvloed door
deze schema’s. Schema’s dienen als framework en leiden ons gedachten, keuzes en gedrag. Het
ontwikkelen van een framework voor onderzoeksmethoden is erg belangrijk om alle informatie
hierover te integreren en organiseren om zo het grote plaatje van onderzoeksmethoden te
begrijpen. Het doel van dit hoofdstuk is om een schema te ontwikkelen over onderzoek. De kern
van dit schema is dat al het gedragsonderzoek probeert om variabiliteit in gedrag, hoe en waarom
gedrag varieert tussen situaties en individuen en verandert met tijd, te verklaren.

Variabiliteit en onderzoeksproces
Onderzoek draait om variabiliteit meten, er zijn 5 redenen te onderscheiden waarom dit de kern
is:

● Gedragswetenschappen houden zich bezig met het meten van variabiliteit in gedrag: De kern
is hoe en waarom mensen verschillen onderling, tussen situaties en over tijd.
Gedragswetenschappen houden zich dus bezig met onderzoeken van de oorzaken die
gedrag laten verschillen, dit is ook de kern van gedrag begrijpen;

● Onderzoeksvragen in alle gedragswetenschappen zijn vragen over variabiliteit in gedrag: Als
we bijvoorbeeld willen weten hoe slaap de prestatie op cognitieve taken beïnvloed vragen
we eigenlijk hoe de hoeveelheid slaap die iemand krijgt zijn prestatie laat variëren;

● Onderzoek moet zo ontworpen worden dat het de onderzoeker in staat stelt vragen over de
variabiliteit in gedrag te beantwoorden: Onderzoeksdesigns moeten ervoor zorgen dat we
alle factoren kunnen vaststellen die samenhangen met verschillen in gedrag;

● Het meten van gedrag omvat de beoordeling van variabiliteit in gedrag: wat we ook meten,
we willen dat het nummer wat we aan gedrag toeschrijven op een betekenisvolle manier
correspondeert met het gedrag dat we willen meten. We willen dat verschillen in getallen
ook daadwerkelijk corresponderen met verschillen in gedrag;

● Statistische analyses worden gebruikt om de geobserveerde verschillen in gedragsdata te
beschrijven en verklaren: Het analyseren van de data die is verzameld is altijd een stap van
onderzoek. Als een studie is afgerond hebben we een grote reeks nummers die
verschillen in gedrag reflecteren. Door middel van statistiek willen we deze data
samenvatten en vragen beantwoorden over waarom de getallen (en dus gedrag)
verschillen. Dit kan met twee soorten statistieken.

De eerste is beschrijvende statistiek, hierbij wordt gedrag van de participanten beschreven en
samengevat. Een groot aantal scores wordt gereduceerd naar interpreteerbare getallen. De
tweede soort is inferentiële statistiek. Deze soort wordt gebruikt om conclusies te trekken over
de betrouwbaarheid en de generaliseerbaarheid van bevindingen.

Variantie: een index van variabiliteit
Gezien het belang van het begrip variabiliteit hebben onderzoekers een numerieke index nodig
voor de variabiliteit in hun data om bepaalde statistische analyses te kunnen uitvoeren. De
statistiek variantie wordt gebruikt om de mate van geobserveerde variabiliteit in het gedrag van
participanten uit te drukken.
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Een conceptuele uitleg van variantie
De range (het verschil tussen de hoogste en laagste score) wordt soms gebruikt om variabiliteit in
data uit te drukken, dit heeft wel limitaties. De range neemt scores tussen de hoogste en laagste
score niet mee en vertelt ons niks over hoe ver die uit elkaar liggen. Twee hele verschillende
verdelingen van scores kunnen alsnog dezelfde range hebben.
Wanneer we het hebben over variatie doen we dit meestal in referentie naar een standaard. Het
gemiddelde (mean) is hier heel bruikbaar voor, Dit is de som van een set van scores gedeeld door
het aantal scores. Dit kan je zien als een steunpunt waar alle andere scores op balanceren. Als de
meeste scores dicht bij de mean liggen dan is de variantie in de data klein, als scores meer en
verder gespreid liggen is de variantie groot.

Een statistische uitleg van variantie
Om een beter beeld te krijgen van wat de variantie ons precies vertelt over de data moeten we
het statistisch uitdrukken. Door vijf simpele stappen te volgen kunnen we zien wat variantie is:

1. Eerst moet het gemiddelde (mean) van de data uitgerekend worden. Dit is simpelweg de
som van de scores gedeeld door het aantal scores. Statistici gebruiken vaak het symbool

of om te verwijzen naar de mean;𝑥 𝑦
2. Vervolgens moet het gemiddelde van elke score worden afgetrokken, dit is de deviation

score ;(𝑦
𝑖

−𝑦)
3. Je zou kunnen denken dat we alle deviation scores zouden kunnen optellen om een totale

variabiliteit score te krijgen, maar dit telt altijd op tot 0 omdat de scores positief en
negatief gespreid liggen rond het gemiddelde, Door elke deviation score te kwadrateren,
worden alle mintekens weggewerkt ²;(𝑦

𝑖
−𝑦)

4. Nu wordt de wortel van alle deviation scores bij elkaar opgeteld. Dit getal, de the sum of
the  squared  deviations  of  the  scores  from  the mean, is een kernelement van veel

statistische analyses ²;∑(𝑦
𝑖

−𝑦)

5. In stap vier hebben we een index geproduceerd van de totale variabiliteit in onze data
gecreëerd, de total sum of squares, maar dit getal wordt beïnvloed door het aantal
scores. Daarom wordt dit getal gedeeld door het totale aantal participanten in onze
studie -1, waarom er 1 van wordt afgetrokken is nu nog niet belangrijk. Dit geeft ons de

variantie van onze data, aangegeven met . = s²𝑠²
 ∑(𝑦

𝑖
−𝑦)².

𝑛−1

Systematische en error variantie
De totale variantie in een dataset kan altijd worden opgedeeld in twee delen: Totale variantie =
systematische variantie - error variantie. Een onderzoeker is gewoonlijk geïnteresseerd in of de
variabiliteit in één variabele op een systematische wijze gerelateerd is aan de variabiliteit van een
andere variabele.
Systematische variantie is het deel van de totale variabiliteit in het gedrag van een participant
die op een voorspelbare manier gerelateerd is aan de variabelen die worden onderzocht door de
onderzoeker. Als het gedrag van een participant op een systematische manier varieert als
bepaalde andere variabele veranderen dan heeft de onderzoeker bewijs voordat die variabele de
verandering in gedrag veroorzaken,
Error variantie duikt op wanneer het gedrag van de participanten wordt beïnvloed door
variabelen die de onderzoeker niet onderzoekt, zoals humeur of concentratie. Zelfs als de
onderzoeker heeft bepaald hoeveel van de variantie is gerelateerd aan de onderzochte
variabelen blijft een deel van de variantie dus niet verklaarbaar door het onderzoek.
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Hoe meer error variantie er is in de data hoe moeilijker het te bepalen is of de gemanipuleerde
variabelen daadwerkelijk gerelateerd zijn aan het onderzochte gedrag. Onderzoekers willen de
error variantie daarom zo klein mogelijk houden. Het is belangrijk dat onderzoekers weten
hoeveel variantie in de dataset error variantie is en hoeveel van de variantie systematisch is, er
worden statistische methodes gebruikt om dit uit te vinden.

Effect size: de kracht van de relatie beoordelen
Onderzoekers zijn niet alleen geïnteresseerd in of variabelen gerelateerd zijn maar ook in de
sterkte van die relatie. De sterkte van deze geobserveerde relaties wordt beoordeeld door de
proportie van de totale variantie die systematisch is. De proportie verklaarde variantie =
systematische variantie gedeeld door totale variantie. De sterkte van de relatie tussen twee
variabelen wordt uitgedrukt in effect size.
De proportie verklaarde variantie ligt altijd tussen 0 en 1 omdat het gaat om een proportie, of
anders bekeken percentage, van de totale variantie. Hoe hoger de proportie en dus hoe hoger
het aandeel van systematische variantie tegenover error variantie hoe sterker de geobserveerde
relatie is.

Er zijn verschillende statistieken om de effect size uit te drukken en te beoordelen. De meest
gebruikte, is Cohen’s d. De relatie is hier zwak rond .01, gemiddeld rond .06 en sterk als die groter
is dan .15. Dat .15 als sterk wordt gezien kan je verbazen aangezien 85% van de variantie dan nog
steeds error variantie is. Het is echter belangrijk om te bedenken dat psychologische variabelen
(zoals zelfvertrouwen), beïnvloedt worden door erg veel andere variabelen. In
gedragswetenschappen vinden we eigenlijk bijna nooit meer dan 40% verklaarde variantie en
veel effecten zijn nog kleiner.

Meta-analyse: Systematische variantie tussen studies
De effect size die wordt gevonden in een bepaalde studie kan slechts een schatting geven van de
‘werkelijke’ proportie verklaarde variantie omdat de gevonden effect size afhangt van
karakteristieken van de studie (steekproefgrootte, etc.). Verschillende studies die dezelfde
variabele(n) onderzoeken kunnen dus verschillende schattingen van systematische variantie
vinden. Daarom beoordelen onderzoekers de sterkte van de relatie tussen twee variabelen het
liefst op basis van de schatting van veel verschillende studies. Het gemiddelde van deze
schattingen geeft namelijk een accuratere schatting van de mate waarin de variabele “echt
gerelateerd zijn”. De procedure om de resultaten van een groot aantal verschillende studies te
integreren en analyseren heet meta-analysis. Voor elke studie wordt de effect size berekend of
geschat, vervolgens wordt de gemiddelde effect size tussen de studies berekent. Een gemiddelde
schatting van de verklaarde variantie gebaseerd op verschillende studies geeft sterker bewijs
voor een bepaalde relatie dan een enkele studie.

In de meeste meta-analyses wordt niet alleen de mate waarin variabelen gerelateerd zijn
berekend, maar er worden ook factoren geïdentificeerd die de relatie beïnvloeden. Zo kan
bijvoorbeeld gender de relatie tussen twee variabelen beïnvloeden en een mediërende rol
spelen. Eerst zoeken wetenschappers uit of twee variabelen überhaupt wel aan elkaar
gerelateerd zijn, en vervolgens wordt er gekeken naar hoe ze gerelateerd zijn.

De zoektocht naar systematische variantie
Uiteindelijk is al het gedragsonderzoek op zoek naar systematische variantie. Onderzoekers
willen altijd zoveel mogelijk systematische variantie vinden en zo min mogelijk error variantie. Pas
als er bepaald is dat twee variabelen gerelateerd zijn, zullen wetenschappers onderzoeken hoe ze
gerelateerd zijn.
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Oefenvragen

Beste student, Slim Academy heeft een aantal oefenvragen voor jou gemaakt! Dit zijn oefenvragen
enkel om te testen of je goed hebt gestudeerd. Ze zijn niet per definitie een weerspiegeling van de
tentamenvragen.

1. Welk van de onderstaande stelling(en) over de empirische cyclus is/zijn juist?
I: Tijdens de inductiefase wordt uit een algemene theorie of hypothese een toetsbare
onderzoeksvraag afgeleid.
II: Tijdens de evaluatiefase wordt de algemene hypothese of theorie verworpen en de
theorie kan dan worden aangepast of verbeterd.

a. Stelling I en II zijn juist
b. Stelling I is juist, stelling II is onjuist
c. Stelling II is onjuist, stelling II is juist
d. Stelling I en II zijn onjuist

2. De variabele IQ wordt voor een onderzoek over de relatie tussen IQ en sociale
vaardigheden gemeten met een IQ-test. Wat is het meetniveau van deze variabele?

a. Nominaal
b. Ordinaal
c. Interval
d. Ratio

3. Onderzoekers maken regelmatig gebruik van kanssteekproeven. Wanneer een
onderzoeker ervoor kiest om elke 7de persoon te gebruiken in het onderzoek, is er sprake
van een (1). Wanneer een onderzoeker participanten selecteert door een bepaalde school
te selecteren in de gemeente Vleuten, dan is er sprake van een (2). Een eenvoudige
manier om ieder lid van de populatie een gelijke kans te geven om voor deelname aan
het onderzoek geselecteerd te worden is door een (3).

a. 1= systematische steekproef, 2= clustersteekproef, 3= simpele random steekproef
b. 1= gestratificeerde random steekproef, 2= simpele random steekproef, 3=

clustersteekproef
c. 1= simpele random steekproef, 2= clustersteekproef, 3= systematische steekproef
d. 1= systematische steekproef, 2= gestratificeerde random steekproef, 3=

clustersteekproef
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Antwoorden oefenvragen

Hoorcollege 1
1. C

Hoorcollege 2
2. C
3. A
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Inleiding in de Methodologie en Statistiek SPSS

Introductie
In dit hoofdstuk vind je het stappenplan voor de SPSS stof van blok 1. De besproken stof komt uit
de 7e druk van Pallant’s SPSS Survival Manual en uit de video’s van Smit.

Een codeboek overnemen in SPSS

1. Ga in SPSS naar Variable view.
2. Elke regel is nu 1 variabele, deze ga je definiëren.
3. Nu neem je uit het codeboek bijvoorbeeld de naam over. Een aantal gegevens worden

standaard ingevoerd.
4. Terug naar Data view.

Data invoeren in SPSS

1. Ga in SPSS naar Data view.
2. Neem de tabel uit het werkboek over.
3. Decimalen zijn automatisch, met komma’s.
4. Ingevoerde waarde corrigeren doe je ook in Data view, je klikt dubbel op de waarde

die je wil veranderen en kan dan een nieuwe waarde intypen.

Labels, Values en Missing definiëren

1. Ga in SPSS naar Variable view.
2. Bij Label typ je een uitgebreidere beschrijving in van de name.
3. Bij Values typ je in het dialoogvenster de waarde en de betekenis van die waarde in.

Ook de waarde voor onbekend zet je hier in. (Bijv. 1 = man, 9 = onbekend)
4. Bij Missing typ je de waarde in die je bij values als onbekend hebt aangegeven.

Databestand opslaan

1. Ga in het datamenu (deze zit op de menubalk bovenin) naar files→ save as. Meestal
wordt er in het werkboek een specifieke naam voor het bestand aangegeven.

Tip: maak voor de SPSS een map aan op je desktop en sla hier al je bestanden in op, bij het
inleveren kan je de bestanden dan makkelijk terugvinden.
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Data sorteren op een specifieke variabele

1. Ga in het datamenu (deze zit op de menubalk bovenin) naar sort cases.
2. Selecteer de eerste variabele en daarna de tweede, bijvoorbeeld: als er in de vraag

staat ‘selecteer eerst op basis van geslacht en dan op lengte’ houd je deze volgorde ook
aan in sort cases.

Uitvoerbestand opslaan

1. Ga naar het uitvoerbestand.
2. Klik op File → Save as.

Een staafdiagram maken van een variabele

1. Klik in de menubalk op Graphs → Legacy Dialogs → Bar.
2. Klik op Define met de standaardinstellingen.
3. Selecteer de variabele waar naar gevraagd wordt en zet deze in het veld voor de x-as,

category axes.
4. Klik op Ok.

Staafdiagram maken van 1 variabele, gericht op 1 deel van een andere variabele
(bijvoorbeeld ‘het sterrenbeeld van alleen vrouwen’)

1. Klik op de menubalk op Data → Select Cases.
2. Dialoogvenster wordt geopend, staat standaard op all cases.
3. Klik op if conditon is satisfied→ if…
4. Tweede dialoogvenster wordt geopend, hier selecteer je de variabelen die je nodig

hebt.
5. Selecteer de variabele ‘geslacht’ en = 1. Klik op Continue.
6. Klik op Ok.
Let op: SPSS voegt een filtervariabele toe, 0 = zit niet in de verdeling, 1 = wel in de
verdeling, nooit gebruiken voor een analyse!
7. Klik op de menubalk op Graphs → Legacy Dialogs → Bar→ Define
8. Zet de variabele ‘sterrenbeeld’ op de x-as, category axes.
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Een selectie maken van een deel van een variabele en deze gebruiken om een
staafdiagram van een andere variabele te maken (bijvoorbeeld ‘het sterrenbeeld van
iedereen met een lengte van/langer dan 1,75’)

1. Klik op de menubalk op Data → Select Cases → If condition is satistfied → if…
2. Selecteer de variabele ‘lengte’ en groter dan en gelijk aan 1,75 → Continue → Ok.
3. De selectie is nu gemaakt op basis van lengte.
4. Ga naar Graphs → Legacy Dialogs → Bar → variabele ‘sterrenbeeld’ op category axes

→ Define.

Een selectie ongedaan maken

1. Klik op Data → Select Cases → All cases → Ok.
2. Of; klik op Data → Select Cases → Reset.

Een frequentietabel maken

1. Klik op de menubalk op Analyze → Descriptive Statistics→ Frequencies.
2. Selecteer in het dialoogvenster de variabelen.
3. Voor verdere eisen zoals de standaarddeviatie of het gemiddelde klik je op Statistics

en selecteer je deze.
4. Klik op Ok, in de output verschijnen de frequentietabel en de opgevraagde statistieken.

Een selectie maken binnen een variabele (bijvoorbeeld alle kinderen binnen een groep)

1. Klik op de menubalk op Data → Select Cases → If condition is satisfied → if… →
bijvoorbeeld If group = 1.

2. Klik op Continue → Ok.

Een tabel met beschrijvende statistieken opvragen (minimum, maximum, gemiddelde
etc)

1. Klik op de menubalk op Analyze → Descriptive Statistics→ Descriptives.
2. Selecteer de variabelen.
3. Klik op Options en selecteer de statistieken die je nodig hebt.
4. In de output verschijnen de statistieken
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Een histogram met een normaalcurve maken met Legacy Dialogs

1. Klik op de menubalk op Graphs → Legacy Dialogs → Histogram.
2. Verplaats je variabele naar Variable.
3. Vink de optie Display Normal Curve aan.

Een histogram met een normaalcurve maken met Chart Builder

1. Klik op de menubalk op Graphs → Chart Builder.
2. Selecteer linksonder Histogram → Simple histogram.
3. Kies de variabele en verplaats die naar het x-as veld.
4. Vink de optie Display Normal Curve aan.

Het aantal intervallen in een histogram aanpassen met de Chart Editor

1. Dubbelklik in het uitvoerbestand op de grafiek.
2. Selecteer de staven (iedere staaf is een interval), en dubbelklik. Er wordt een

dialoogvenster geopend.
3. Kies het tabblad Binning, kies bij 2 voor de optie Custom.
4. Bij het aantal intervallen kies je het nieuwe aantal, klik op apply.

Standaardscores berekenen

1. Klik op de menubalk op Analyze → Descriptive Statistics→ Descriptives.
2. Selecteer de variabele, vink safe standardized values as variables aan.
3. In het databestand wordt een nieuwe variabele aangemaakt, dit zijn de

standaardscores.

Een scatterplot maken met Legacy Dialogs

1. Klik op de menubalk op Graphs → Legacy Dialogs → Scatter Dot.
2. Kies Simple scatter en klik op Define.
3. Selecteer de ene variabele op de x-as en de andere op de y-as.

18



Samenvatting Inleiding in de Methodologie en Statistiek 2022/2023

Nawoord

Hèhè, het is je gelukt! Je hebt jouw samenvatting uitgelezen.
 
Wil je meer vertrouwen tanken voor het tentamen? Geen paniek! Wij kunnen je verder helpen in
de vorm van handige abonnementen. Met een abonnement ontvang jij de samenvattingen altijd
met korting en als eerste in huis! Nieuwsgierig geworden naar een abonnement? Bekijk dan onze
website!

Nu 1 MAAND GRATIS bij een abonnement!
Wil jij de Slim Academy samenvattingen van jouw vakken altijd als eerste  in huis hebben zodat jij
op tijd kan beginnen met studeren? Gebruik dan de kortingscode STARTSLIM bij het afsluiten van
een abonnement en krijg de eerste maand van jouw abonnement helemaal gratis!
Ga hiervoor naar www.slimacademy.nl en kies je jaar. Deze code is geldig t/m 30 september
2022.

Werken bij
Slim Academy is altijd op zoek naar gemotiveerde studenten! Lijkt het je leuk om bij ons aan de
slag te gaan met het samenvatten en nakijken van samenvattingen? Dan is de rol van Studieheld
zeker iets voor jou. Je kunt werken vanuit huis, krijgt een riante vergoeding en je hebt een
studiegerelateerde bijbaan die goed op je cv staat. Heb je interesse? Stuur dan jouw motivatie en
cv naar klantenservice@slimacademy.nl.

Kom in contact met Slim Academy
Wil je op de hoogte blijven van de ontwikkelingen bij Slim Academy? Kom in contact via:
www.slimacademy.nl                  
@SlimAcademy.nl
klantenservice@slimacademy.nl
010 214 32 45

We wensen je veel succes met studeren en het halen van jouw tentamens!

Te�m ���� Aca���y
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